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An Overview of R Markdown



SOCIETY OF ACTUARIES  
An�trust Compliance Guidelines

Ac�ve par�cipa�on in the Society of Actuaries is an important aspect of membership. While the posi�ve contribu�ons of professional socie�es and associa�ons are well-
recognized and encouraged, associa�on ac�vi�es are vulnerable to close an�trust scru�ny. By their very nature, associa�ons bring together industry compe�tors and other
market par�cipants.

The United States an�trust laws aim to protect consumers by preserving the free economy and prohibi�ng an�-compe��ve business prac�ces; they promote compe��on.
There are both state and federal an�trust laws, although state an�trust laws closely follow federal law. The Sherman Act, is the primary U.S. an�trust law pertaining to
associa�on ac�vi�es. The Sherman Act prohibits every contract, combina�on or conspiracy that places an unreasonable restraint on trade. There are, however, some
ac�vi�es that are illegal under all circumstances, such as price fixing, market alloca�on and collusive bidding.

There is no safe harbor under the an�trust law for professional associa�on ac�vi�es. Therefore, associa�on mee�ng par�cipants should refrain from discussing any ac�vity
that could poten�ally be construed as having an an�-compe��ve effect. Discussions rela�ng to product or service pricing, market alloca�ons, membership restric�ons,
product standardiza�on or other condi�ons on trade could arguably be perceived as a restraint on trade and may expose the SOA and its members to an�trust enforcement
procedures.

While par�cipa�ng in all SOA in person mee�ngs, webinars, teleconferences or side discussions, you should avoid discussing compe��vely sensi�ve informa�on with
compe�tors and follow these guidelines:

Do not discuss prices for services or products or anything else that might affect prices
Do not discuss what you or other en��es plan to do in a par�cular geographic or product markets or with par�cular customers.
Do not speak on behalf of the SOA or any of its commi�ees unless specifically authorized to do so.
Do leave a mee�ng where any an�compe��ve pricing or market alloca�on discussion occurs.
Do alert SOA staff and/or legal counsel to any concerning discussions
Do consult with legal counsel before raising any ma�er or making a statement that may involve compe��vely sensi�ve informa�on.

Adherence to these guidelines involves not only avoidance of an�trust viola�ons, but avoidance of behavior which might be so construed. These guidelines only provide an
overview of prohibited ac�vi�es. SOA legal counsel reviews mee�ng agenda and materials as deemed appropriate and any discussion that departs from the formal agenda
should be scru�nized carefully. An�trust compliance is everyone’s responsibility; however, please seek legal counsel if you have any ques�ons or concerns.
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Presenta�on Disclaimer

Presenta�ons are intended for educa�onal purposes only and do not replace independent professional
judgment. Statements of fact and opinions expressed are those of the par�cipants individually and,
unless expressly stated to the contrary, are not the opinion or posi�on of the Society of Actuaries, its
cosponsors or its commi�ees. The Society of Actuaries does not endorse or approve, and assumes no
responsibility for, the content, accuracy or completeness of the informa�on presented. A�endees
should note that the sessions are audio-recorded and may be published in various media, including
print, audio and video formats without further no�ce.
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Why is R Markdown important?

Transparency

Reproducibility

ASOP 41 - Actuarial Communica�ons, Sec�on 3.2:

"...the actuary should state the actuarial findings, and iden�fy the methods, procedures,
assump�ons, and data used by the actuary with sufficient clarity that another actuary
qualified in the same prac�ce area could make an objec�ve appraisal of the reasonableness
of the actuary’s work as presented in the actuarial report"

5 / 34

http://www.actuarialstandardsboard.org/wp-content/uploads/2014/02/asop041_120.pdf


Example COVID-19 Report

Data from JHU CSSE COVID-19: h�ps://github.com/CSSEGISandData/COVID-19
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https://github.com/CSSEGISandData/COVID-19


If you want to follow along, you'll need:

R v4.0 or higher, R Studio v1.3 or higher
R packages: �dyverse, rmarkdown, knitr, lubridate, praise, gghighlight,
leaflet, maps, glue, viridis, flexdashboard
Create a new project in R Studio
Save a copy of COVID_US.rmd and download_cleanup.R from
h�ps://github.com/ma�heaphy/pa4_rmarkdown to your project folder
Run download_cleaup.R. If successful, you should see the file covid19-
us.rds in your project folder
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https://github.com/mattheaphy/pa4_rmarkdown


Basics

YAML

Markdown

Code chunks

Extras

 
 
 
 
 
 

Agenda
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1. Create a new RMD file

2. Write a YAML header

3. Write the report using a
combina�on of Markdown and R

4. Render, or "knit" the RMD file into
the output format of your choice

.Rmd	�ile

knitr	&	pandoc

Output

R Markdown YAML

R Markdown Process Flow
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HTML documents
HTML slides shows (ioslides,
beamer, xaringan)
HTML Dashboards
(flexdashboard)
PDF documents (requires a
separate installa�on of LaTeX)

Microso� Word
Microso� PowerPoint

Mul�ple Output formats

10 / 34



Crea�ng an rmd file

Beginners:

File > New File > R Markdown > then choose a template

Experts:

Create a blank file with Ctrl + Shi� + N
Change the document type in the lower-right of the Source pane to R Markdown
Save the file with an .rmd extension
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Kni�ng

Click the Knit bu�on in R Studio

Or, press Ctrl + Shi� + K

Or, knit using the func�on rmarkdown::render

rmarkdown::render("COVID_US.Rmd", output_file = "New England Report.html", 
                  params = list(states = c("Connecticut", "Massachusetts", 
                                           "Rhode Island", "Maine", 
                                           "New Hampshire", "Vermont")))
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YAML Headers
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YAML Headers

The YAML1 header specifies important informa�on about your document

Series of key-value pairs
Starts and ends with ---
Hierarchical - indenta�on ma�ers

---
title: "COVID-19 Analysis"
author: "`r praise::praise('${Adjective} Actuary')`"
date: "2020-09-25"
output: 
    html_document:
        toc: true
        toc_float: true
        theme: flatly
---

[1] YAML = YAML Ain't Markup Language  
For a list of themes, see h�ps://bootswatch.com/3/
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https://bootswatch.com/3/


More on output types

Use these R func�ons in YAML to specify output formats

Output type Func�on

HTML html_document

HTML slide
shows

ioslides_presentation, beamer_presentation,
xaringan::moon_reader

HTML
Dashboard flexdashboard::flex_dashboard

PDF pdf_document

Word word_document

PowerPoint powerpoint_presentation
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High level tags

title: document's �tle
subtitle: document's sub�tle
author: author's name
date: date
params: document variables
runtime: shiny enables shiny
interac�vity

html_document tags

number_sections: whether headers
(#, ##, etc.) should be numbered
toc: table of contents
toc_depth: number of header levels in
table of contents
toc_float: "floa�ng" table of contents
code_folding: allows readers to hide /
unhide R code
theme: load a pre-built theme
css: add your custom theme

Other Common YAML Tags
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Markdown

Most Markdown looks like plain text. Symbols 
can be added for **bold**,*italics*, 
~~strikethrough~~, and `code` formatting.

Inline R code

You rolled a `r sample(1:6, 1)`!

Mathema�cal expressions

$a_x=\sum_{t=1}^{\infty}{v^t}
{_t }{p_x}$

Hyperlinks

[SOA hyperlink](www.soa.org)

Images

![](https://imgs.xkcd.com/comics/here_to_help.png)

Rendered

Most Markdown looks like plain text. Symbols
can be added for bold, italics, strikethrough,
and code forma�ng.

You rolled a 3!

SOA hyperlink

ax = ∑
∞
t=1 v

t
tpx
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file:///C:/Users/HEAPHYM/OneDrive%20-%20Nassau%20Reinsurance%20Group/teaching/using_r_markdown_this_session/www.soa.org


Markdown

# Level 1 header

## Level 2 header

...

- bulleted
  - list

1. numbered
1. list

> "*Insightful comment*", expert

Rendered

Level 1 header

Level 2 header

...

bulleted
list

1. numbered
2. list

"Insigh�ul comment", expert
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R + Markdown = R Markdown

prep(dat) %>% filter(metric %in% c("Cases", "Deaths")) %>% 
    ggplot(aes(cal_date, value)) + geom_line(lwd = 1.05) +
    scale_y_continuous(labels = scales::comma) +
    facet_wrap(~ metric, scales = "free_y") + labs(x = "Date", y = "Count")
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Code chunk skeleton

To create a chunk, press Ctrl + Alt + I
Or select Insert > R within R Studio
Or type it by hand

An empty chunk

```{r}

```

A chunk with a name

```{r the-answer}
2 * sum(1:6)
```

## [1] 42
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Code chunk op�ons

TRUE / FALSE op�ons

echo: Should the R code be printed?
eval: Should the R code be executed?
message and warning: Should messages and warnings be printed?
include: Set to FALSE to execute code but prevent any prin�ng

Op�ons for plots and tables

fig.height, fig.width: Dimensions of output figures in inches
fig.cap: Cap�on

... and many more
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{r, echo=TRUE}

dat %>% group_by(cal_date) %>% summarize(tot_cases = sum(tot_cases)) %>% 
    ggplot(aes(cal_date, tot_cases)) + geom_line()
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{r, echo=FALSE}
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{r, echo=FALSE, fig.height = 3, fig.width = 3}
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Default chunk op�ons

Set defaults at the beginning of each document with knitr::opts_chunk$set
Common prac�ce is to include a chunk named setup
Always set include to FALSE

Example:

```{r setup, include = FALSE}
knitr::opts_chunk$set(echo = FALSE, message = FALSE, warning = FALSE, 
                      fig.height = 6, fig.width = 8)
```
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Parameterized documents

Se�ng up default parameters

params:
    states: "All"

Using parameters in a report

if (params$states[[1]] != "All") dat <- filter(dat, State %in% params$states)

Mul�ple report automa�on with parameters

walk(state.name, ~ rmarkdown::render("COVID_US.Rmd", 
    output_file = str_glue("{.x}.html"), 
    params = list(states = .x)))
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Popular op�ons for tables:

Paged data frames (paged.print =
TRUE)
kable() from the knitr package
datatable() from the DT package

x <- mutate(economics, Year = year(date)) %>% 
  group_by(Year) %>% 
  summarize(`Savings Rate` = 
              mean(psavert) %>% round(1)) %>% 
  tail()

See the knitr and kableExtra styling guide for �ps
on working with kable tables
See the DT package documenta�on for more on
datatables

knitr::kable(x, format = "html")

Year Savings Rate

2010 6.6

2011 7.2

2012 8.8

2013 6.4

2014 7.3

2015 7.7

Working with tables
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https://cran.r-project.org/web/packages/kableExtra/vignettes/awesome_table_in_html.html
https://rstudio.github.io/DT/


Support for other languages

Python, SQL, C++, Julia, Javascript, CSS, and more...
The game-changing reticulate1 package enables switching back and forth between R and
Python

```{python}
x = 3.14
```

```{r}
py$x <- py$x * 2
```

1 See h�ps://rstudio.github.io/re�culate/index.html
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https://rstudio.github.io/reticulate/index.html


Notebooks

R Markdown has notebook-like func�onality similar to jupyter notebooks

In R Studio, click on the gear icon at the top of the source pane and select
"Chunk Output Inline"

All output from code chunks will be printed in the rmd file

Well-suited for exploratory analysis and document dra�ing
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Tutorials and ar�cles at h�ps://rmarkdown.rstudio.com/

R Studio's R Markdown Cheat Sheet: h�ps://rstudio.com/wp-
content/uploads/2015/02/rmarkdown-cheatsheet.pdf

R Markdown: The Defini�ve Guide, by Yihui Xie, J.J. Allaire, and Garre�
Grolemund: h�ps://bookdown.org/yihui/rmarkdown/

R Markdown Cookbook, by Yihui Xie, Christophe Dervieux, and Emily Riederer:
h�ps://bookdown.org/yihui/rmarkdown-cookbook/verba�m-code-chunks.html

Addi�onal Resources
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https://rmarkdown.rstudio.com/
https://rstudio.com/wp-content/uploads/2015/02/rmarkdown-cheatsheet.pdf
https://bookdown.org/yihui/rmarkdown/
https://bookdown.org/yihui/rmarkdown-cookbook/verbatim-code-chunks.html


Thank you!
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